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253 COMBINAZIONI DELLE AZIONI
Ai fini delle verifiche degli stati limite si definiscono le seguenti combinazioni delle azioni. ~

— Combinazione fondamentale, generalmente impiegata per gli stati limite ultimi {SLIT): _ o
vo1-G1 + Yo-Ga = 1P + Yor-Qk1 + Yor- woz- Oz = Yos3-Wo3- Qhs + . (2.5.1) 2 coml?lna2|on| a
— Combinazione carattenistica (rara). generalmente impiegata per gh stati limite di esercizio scacchiera e 1
(SLE) irreversibili. da utilizzarsi nelle verifiche alle tensioni ammissibili di cui al § 2.7: combinazione
G1+ Ga+ P+ Qui + w01 Qua = wos Qs+ .. (2.5.2) “tutto caricato” per
— Combinazione frequente, generalmente impiegata per gli stati limite di esercizio (SLE) ~icarichi verticali
reversibili: (SLU e SLE hanno
G1 + G2 +P+ wi1-Qun + wor-Qra + ws- Qua + . (2.5.3) diversi coeff.)
— Combinazione quasi permanente (SLE), generalmente impiegata per gli effetti a lungo
termine:
G1+ G+ P+wn-Qu + yo-Quy + was- Qs + .. (2.54) ]
— Combinazione sismica, impiegata per gli stati limite ultimi e di esercizio connessi all'azione ] “Tutto caricato” per i
sismica E (v. § 3.2): _ carichi verticali  sismici
E+G+G+P+yyQun+ynQu+. .. (2.5.5) (coeff. carichi sismici) “+” E
— Combinazione eccezionale, impiegata per gli stati limite ultini connesst alle aziomi - ossia diverse combinazioni
eccezionali di progetto Ag(v. § 3.6): per le azioni orizzontali
Gy +G, +P+ A, +W,y - Qu +Vy - Qua +. (2.5.6) sismiche (sistema di forze

Nelle combinazioni per SLE. si intende che vengono omessi 1 carichi Qy; che danno un contributo orizzontali lungo x e y nel
favorevole al find delle verifiche e, se del caso, 1 carichi Go. piano orizzontale)
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J Organizzazione progetto struttura in zona sismica agli stati limite
(SL):
= «SLU non sismico» (capitolo 2, 3, 4 NTC 2008) prevenire il collasso
senza considerare le azioni sismiche
= «SLU sismico» (capitolo 2,3, 7 NTC 2008) prevenire il collasso sotto
azioni sismiche

= «SLE non sismico» garantire durabilita e prestazioni in esercizio
senza considerare il sisma
= «SLE sismico» limitare il danno per uso struttura dopo «modesti
eventi sismici»
 La struttura deve essere progettata verificando tutti gli SL sopra
indicati!!!
(d NON consideriamo azioni eccezionali nel progetto sviluppato nel
corsol!l
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L Analisi allo «SLU non sismica»:

= carichi verticali (G1,G2,Q) moltiplicati per gli opportuni coeff. per lo SLU
(2.5.1, NTC2008)

= 3 combinazioni (comb.) sono considerate tra le diverse possibili: 2 comb. a
scacchiera e 1 comb. tutto caricato.

= 1 comb. diinviluppo nn sismica (inviluppo delle 3 comb. Sopra considerate)

NB:

1- Le combinazioni delle azioni SLU possibili sono molte di piu!!!

2-Diverse comb. SLU sono necessarie per determinare le sollecitazioni massime
in tutte le sezioni di tutti gli elementi della struttura !!!

3-Nel progetto svolto durante il corso ne consideriamo solo 3!!!
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(d Analisi allo «SLU sismica»:

Le azioni verticali:

(G1,G2,pQk) secondo combinazione sismica (2.5.5, NTC2008)

una sola combinazione (tutto caricato!! no scacchiere!!l)

la componente verticale (Ez) dovuta al sisma solo nei casi indicati in 7.2.1 della
NTC2008!!!

DN N

Le azioni orizzontali (due componenti Ex, Ey):

applicate nei baricentri di piano (per l'es. struttura in c.a. progettata durante il corso)
lungo le due direzioni orizzontalix ey

funzione della massa di piano e della accelerazione (acccel.)

Accel. letta sullo spettro di progetto (spettro elastico scalato di q per prog. in classe
duttilita A) allo stato limite ultimo sismico (SLV)!!! Accel in funz. dei periodi propri della
struttura nelle due direzioni x e y (primi due modi traslazionali)

v Azioni distribuite opportunamente tra i piani (exp. 7.3.6 NTC2008)

AN

 Azioni verticali e orizzontali sismiche vanno opportunamente combinate
(2.5.5,7.3.15 NTC2008)
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7.2 CRITERI GENERALIDI PROGETTAZIONE E MODELLAZIONE

7.2.1  CRITERI GENERALI DI PROGETTAZIONE

Le costruziom devono essere dotate di sistenu strutturali che garanfiscano rigidezza e resistenza nei
confronti delle due componenti orfogonali onzzontali delle azioni sismiche. La componente
verficale deve essere considerata solo in presenza di elementi pressoché onzzontali con luce
superiore a 20 m. elemenfi precompressi (con 1'esclusione dei solai di luce inferiore a 8§ m).
element: a mensola di luce supenore a 4 m, strutture di tipo spingente. pilastn i falso, edifici con
piani sospesi, ponfi. costruzioni con isolamento nei casi specificati mn § 7.10.5.3.2 e purché il sito
nel quale la costruzione sorge non ricada in zona 3 o 4. Net cast precisati in § 3.2 5.1 s1 deve moltre
tenere conto della vanabilita spaziale del moto sismico. 51 deve tenere infine conto degli effetti
torsionali che si accompagnano all’azione sismica. A tal fine gli orizzontamenti, ove presenti.
devono essere dotati di rigidezza e resistenza tali da metterli in grado di trasmettere le forze
scambiate tra 1 diversi sistemi resistenti a sviluppo verticale.

Il sistema di fondazione deve essere dotato di elevata rigidezza estensionale nel piano orizzontale e
di adeguata nigidezza flessionale. Deve essere adottata un vnica tipologia di fondazione per una data
struttura in elevazione, a meno che questa non consista di wnita indipendenti. In particolare, nella
stessa struttura deve essere evitato 1'uso contestuale di fondazioni su pali o miste con fondaziom
superficiali. a meno che uno studio specifico non ne dimostri 1'accettabilita o che si tratti di un

ponte. Quando considerare lo Spettro per la componente
verticale (Ez) dell’azione sismica !!!!
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=1
Tk
T

ALLA VARIABILITA SPAZIALE DEL MOTO

RISPOSTA ALLE DIVERSE COMPONENTI DELLAZIONE SISMICA ED

Se la risposta viene valutata mediante analisi statica o dinamica in campo lineare, essa puo essere
calcolata separatamente per ciascuna delle tre componenti; la risposta a clascuna componente, ove
necessarno (v. § 3.2.5.1). e combinata con gh effetti psendo-statici indotti dagli spostamenti relativi
prodotti dalla vanabilita spaziale della componente stessa, utilizzando la radice quadrata della

somma dei quadrati. Gli effett1 sulla struttura (sollecitaziom, deformazioni, spostamenti.

combinafi successivamente, applicando 1a sequenfe espressione
L00-E, +0.30-E, +0.30-E,

con rotazione dei coefficienti moltiphcativi e conseguente individuazione degh effetts p
La componente verticale verra tenuta in confo ove necessario (v. § 7.2.1).

ecc.) sono

(7.3.15)

11 Zravost.

30% Ey

‘ 10p% Ex

Es. di una delle
ossibili
combinazioni 111!

— Combinazione sismica, impiegata per gli stati limite ultinu e di esercizio connessi all’azione

sismuca E (v § 3.2
E+G+G+P+ynQu+ynQu~+...

324 COMBINAZIONE DELL'AZIONE SISMICA CONLE ALTRE AZIONI

Nel caso delle costmuziond civili e industriali le verifiche aghi stati limite ultimi o di esercizio devono
essere effettuate per la combinazione dell azione sismica con le altre azioni gia formitain § 253
che quui si riporta:

G, +G,+P+E+ ijsz-_E (3.2.16)

Gli effetti dell'azione sismica saranno valutati tenendo conto delle masse associate al seguenti
carichi gravitazionali:

(2.5.5)
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1 Calcolo delle azioni Ex ed Ey:

= EX ed Ey calcolate usando lo spettro di progetto, le masse di piano e i periodi
propri (T1 e T2) della struttura lungo x e lungo y!!! NB vogliamo progettare una
struttura con i primi due modi prevalentemente traslazionali («modeste
rotazioni di piano attorno a Z»)

= Exed Ey distribuite tra i piani (ad es con la exp. 7.3.6 NTC2008!!!)
 Applicazione delle forze E sul modello:

= (Calcolo la posizione dei baricentri di ogni piano

= Applico la eccentricita accidentale e sposto i baricentri di piano trovati

= Applico le forze Ex ed Ey nei baricentri di piano combinandole opportunamente
tra loro e con i carichi verticali sismici (verticali sismici distribuiti sulle travi e
alla base di setti e pilastri ad ogni piano o sulle shell!!!)
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(d Calcolo delle masse di piano e della posizione dei baricentri di

piano usando i carichi indicati dalla norma NTC2008!!!!

3.24 COMBINAZIONE DELLAZIONE SISMICA CON LE ALTRE AZIONI

Nel caso delle costruziom civili e industriali le verifiche agh stati limite ultioi o di esercizio devono
essere effettuate per la combinazione dell’ azione sismica con le altre aziom gia formtain § 253 e

che qui 51 riporta:
G, +G,+P+E+ ij:th (3.2.16)
Gl effetti dell'azione sismica saranno valutati tenendo conto delle masse associate al seguenti
carichi gravitazionali:
23
Gy + G, —E_.'U,":j"-:hj .

I valoni de1 coefficienti w,; sono riportati nella Tabella 2.5.1

(3.2.17)

Nel caso de1 ponti, nelle espressiom 3.2.16 e 3.2.17 51 assumera per i canichi dovuti al transito der

mezzi y,; = 0,2, quando nilevante.



Progetto struttura: ANALISI SISMICA

Calcolo delle masse di
piano e della posizione dei
baricentri di piano !!!!

G+ G, _E_.'-Pljchj . (3.2.17)

I valori dei coefficienti y.; sono riportati nella Tabella 2.5.1

el caso dei ponti, nelle espression 3.2.16 e 3.2.17 si assumera per 1 carichi dovufi al transito dei
mezzi y,; = 0.2 . quando rilevante.

Altre combinaziom sono da considerare in funzione di specifici aspetti (p. es. fatica, ecc.).
Nelle formmle sopra riportate il simbolo + vuol dire combinato con.
I valori dei coefficienti parziali di sicurezza v € vy sono datiin § 2.6.1, Tab. 2.6.1

Tabella 2.5.1 - Valori dei cogfficiens &i combinazions

Categoria/Azione variahile W | Wy | Wy
Categona A Ambienfi ad uso residenziale 07 05| 0,3
Categoria B Uffici 07 10503
Categona C Ambient: suscettibili di affollamento 07 07| 06
Categora I} Ambienti ad uso commerciale 0,7 07| 06
Categonia E Biblioteche, archivi, magazrzing e ambient ad uso mdusinale 1o ) 0% ) 08
Categoria F Rimesse e parchegg (per autovercol di peso = 30 k) 07107 ] 06
Categonia & Fimesse e parchegz (per autovercol di peso = 30 kI 0710503
Categoria H Coperture 00 ) 00 00
Vento 06 |02 0,0
WNeve (aquota = 1000 mslm) 05 102 ] 00
Neve (aquota = 1000 m s ]lm) 07105 02
Vanaziom termiche 06 | 05| 00
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Per ciascun livello, le masse si calcolano dai pess sismici dividendoli per 'accelerazione di gravita g

3 N . N . : . . ) )
= 981 m/s; le masse associate agli spostamenti lungo X e Y sono ovviamente uguali. La D Ad Ognl pla no hO
massa associata al grado di liberta rotazionale & data dal prodotto delle masse per il quadrato

del raggio di inerzia o, Tali quantiti sono assegnate direttamente al baricentro del relativo Impalcatl rlgldl

livello, coerentemente con l'tpotesi di impaleato infinitamente rigido. D - ™ H
pcotrenen _ ni piano h radi di

Il rageio di imergia p € calcolato assumendo tutte le masse spalmate uniformemente sulla Og piano ha 3 8 ad d

superficie dell'edificio, la quale é assunta rettangolare e di 16,40 x 25,40 m; conseguentemente, |ibe rté (2 traslazioni e

accettando tale approssimazione, risulta:

una rotazione di piano)

_ |a*+b? ,_a‘+b’ —16‘43+25’41-?62 9
P TPt T . em [ Calcolo le due masse
con a e b dimensioni della proiezione verticale dell’edificio. traslazionali (ugua li tra

loro) e «la massa

Progpetio 201 Masse ai part impaicati

W (kN) M=W/g() L=Mpg’ (tn) rotazionale lp»
1° lvelle 3958 4 30738
2° livello 3783 3806 29372
3° lvello 37m 7 28741
4° livello 3299 336 25614

NB raqgqio di inerzia p nn sempre si calcola con la formula qui riportata!!! Questa
formula vale per impalcati rettangolari con massa uniformemente distribuita!!!
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Strutture deformabili torsionalmente ECS:

Una formulazione pid corretta & riportata nell'Eurocodice 8 al punto 4.2.3.2 {6):

i, &il raggw giratore della massa del piana in piarta [radice quadrata del mppodo
tra (a) il momenio di inerzia polare della massa del pano in panta rispetio al
centro di massa del plano e (b) la massa del piano).

NB considerare!ll:

= |a reale geometria dell impalcato!!!
= |a presenza di aperture in esso!!!

= verificare che I'impalcato sia rigido

o B (L ;;B"] . E' importante notare che la formula riportata in normativa & valida per:
A o
Py = Foo= By = E.f* _;_.jg* _p.gll+B) Impalcati di forma rettangolare
2 12 Distribuzione di massa uniforme

D
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 Verificare che gli impalcati siano rigidi (soletta, sistema di travi,
collegamento porzioni impalcato se sono presenti aperture) e in
grado di «trasmettere il taglio tra i vari telai della struttura»

 Calcolare corretta «massa rotazionale» (forma impalcato non
rettangolare, presenza aperture)

 Si assume che tutti i carichi verticali e quindi le masse sismiche
siano distribuiti secondo una comb. tutta caricata senza
scacchierel!ll
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[ Si lavora impalcato per impalcato

1 Si divide I'impalcato in sotto elementi (rettangoli,...) con pesi
diversi (propri e/o accidentali) di cui si conosce la posizione dei
baricentri

d «Si schiacciano sul piano» la meta dei pesi (spettanti
all’interpiano) delle tamponature esterne, delle porzioni dei
pilastri e dei setti e delle scale sopra e sotto il piano considerato

d La posizione dei baricentri delle sezioni degli elementi
«schiacciati sul piano» sono proiettate sul piano dell’impalcato
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Fig. 2.8  Determinazione del baricentro
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La determinazione della posizione del baricentro ¢ fatta con applicazione del feorema di
[-“arignon che presuppone il calcolo dei momenti statici rispetto all’asse X'

Si osserva che, per ragioni di simmetria, sono nulli i momenti statici 5. di balcons, tamponature,
pilastri e travi.

Per il primo livello si ha:

Prospetts 2.12 Momento statico rispetto all'asse X'

Elemento W Se
Solaio 6.21 kN/m’ 6,21-7.30-3-(7,00-7,30/2)= +456 kNm
Scala 6,56 kN/m” 6,56°3-6,70:(7,00-6,70/2)= -481 kNm

Trave a mnocchio 225kN/m 2 25-2:6,70-(7,00-6,70/2)= -110 kNm
Ei er:'13ﬁ‘ kNl'Il

La distanza del baricentro dall’asse X'é& datada .5 /I, =—136/3958 = —0,03m .

Per gli altr1 hivelli s1 ha:

2 liells 2,5, [W, =—136/3783=—0,04 m
3 livells 2,5, [y =—136/3701=—0,04 m

# livello Z,5, [V, =—296/3299 = —0,09 m
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NTC 2008:
7.2.6 CRITERI DI MODELLAZIONE DELLASTRUTTURA E AZIONE SISMICA

Per tenere conto della variabilita spaziale del moto sismico, nonché di eventuali
incertezze nella localizzazione delle masse, al centro di massa deve essere attribuita una
eccentricita accidentale rispetto alla sua posizione quale deriva dal calcolo. Per i soli
edifici ed in assenza di piu accurate determinazioni 1’eccentricita accidentale in ogni
direzione non puo essere considerata inferiore a 0,05 volte la dimensione dell’edificio
misurata perpendicolarmente alla direzione di applicazione dell’azione sismica. Detta
eccentricita e assunta costante, per entita e direzione, su tutti gli orizzontamenti.

-

e OF
e, =10.05L, —tt = o{-c.

> — M O

e, = +0.05L, Jd b
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(J La norma NTC2008 ci dice di considerare una eccentricita accidentale
con cui spostare i baricentri di piano tutti in modo concorde

| quattro possibili spostamenti fanno si che le combinazioni sismiche
siano 8 x 4 =321111

(J Nel progetto sviluppato durante il corso consideriamo per semplicita
un solo spostamento dei baricentri di piano e quindi solo 8 comb.
sismichel!!l

Lo spostamento dei baricentri scelto (per semplicita qui nel corso)
deve essere giustificato come caso di interesse (es incremento azioni
su particolari elementilll Elementi dove ho problematiche
interessanti!!!)
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O Nel progetto sviluppato durante il corso si considera una analisi con forze
equivalenti anche per strutture non regolari (cmq occorre verificare gli effetti di
guesta semplificazione!!!):

= |e azioni Ex ed Ey sono forze equivalenti nei baricentri di piano che
devono essere opportunamente combinate tra loro (7.3.15 NTC2008,
30% di una con 100% dell altra! Con rotazione dei coeff. tra Ex ed Ey)

= Ex ed Ey agiscono per una data direzione (rispettivamente X, y) secondo
due possibili versi!!!

= Tutte e 8 le combinazioni di Ex ed Ey che ne risultano hanno in comune
gli stessi carichi verticali (G1k,G2k,pQk) distribuiti secondo la comb. tutto
caricato!!!

Le 8 combinazioni sismiche risultano pertanto:

C4 = Ecs+ G1+ Gz + 20k C8 = Eca+ G1+ G2+ J2Qk
C5 =Ecs+ G1+ Gz + Y20k C9 = Ecio+ G1+ Gz + Y20k
Co=Ecr+ G1+ G2+ 20k C10 = Ecu1+ G1+ G2+ Y2Qk

C7 = Ecs+ G1+ Gz + 20k Cll = Eciz+ G1+ G2+ Y2Qk
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1- Ecs=+1,00 Fx+ 0,30 Fy 5- Eca=+ 0,30 Fx+ 1,00 Fy
2- Ecs=+ 1,00 Fx- 0,30 Fy 6- Eci0=+ 0,30 Fx- 1,00 Fy
3- Ec7=-1,00 Fx+ 0,30 Fy 7- Ec11=-0,30 Fx+ 1,00 Fy
4- Ece=-1,00 Fx-0,30 Fy 8- Ec12=-0,30 Fx- 1,00 Fy
F 1WFI =F bt
— - ot =

400 F
) ) L L, 4
L3 i 1
160 F uF ME A00F
WF AA0F
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 Nel progetto consideriamo:

= inviluppo sismico delle 8 comb sismiche
" inviluppo non sismico delle 3 comb. SLU
= inviluppo dei due inviluppi

( NB vedremo nella progettazione degli elementi strutturali
qguali combinazioni considerare!!!!
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(INel progetto sviluppato durante il corso:

" costruiamo un modello della struttura in un software
di calcolo, assegnando le caratteristiche dei materiali
(moduli elastici fessurati per lo SLU), le geometrie di
elementi e sezioni e le masse nei baricentri di piano.

" valutiamo la regolarita strutturale in pianta ed in
elevazione

= verifichiamo la tipologia strutturale
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dLa regolarita di una struttura ha effetti sul tipo di analisi sismica

che si puo adottare e sul valore di alcuni coefficienti (es valore
del fattore q)

(A Durante lo svolgimento del progetto assegnato nel corso per

semplicita, usiamo il metodo di analisi con forze sismiche
equivalenti

Il metodo semplificato di analisi vale per strutture regolari:
controlleremo poi gli effetti di tale scelta!!!!



7.2.2  CARATTERISTICHE GENERALI DELLE COSTRUZIONI
Regolarita

Le costruzioni devono avere, quanto pit possibile, struttura iperstatica caratterizzata da regolarita in
pianta e in altezza. Se necessario cid pud essere conseguito suddividendo la struttura, mediante
giunti, in vnita tra loro dinamicamente indipendenti.

Per quanto riguarda gli edifici, una costruzione & regolare in pianta se futte le seguenti condiziom

sono rispettate:

a) la configurazione in pianta & compatta e approssimativamente simmetrica rispetto a due direzioni
ortogonali, in relazione alla distribuzione di masse e rigidezze;

b) il rapporto tra 1 1afi di un rettangolo in cui la costruzione risulta inscritta € inferiore a 4;

c) nessuna dimensione di eventuali rientri o sporgenze supera il 25 % della dimensione totale della
costruzione nella cormspondente direzione;

d) gl orizrontamenti possono essere considerati infinitamente rigidi nel loro piano rispetto agli
elementi verticali e sufficientemente resistenti.

Sempre riferendosi agli edifici, una costruzione € regolare in alfezza se tutte le seguenti condizioni
s0n0 rispettate:

€) tuttl 1 sistemi resistenti verticali {quali telai e pareti) si estendono per tutta 'altezza della
costruzione:

f) massa e rigidezza rimangono costanti o variano gradualmente, senza bruschi cambiamenti, dalla

base alla sommita della costruzione (le variazioni di massa da vn orizzontamento all’altro non

superano il 25 %, la rigidezza non si riduce da un orizzontamento a quello sovrastante pit del

30% e non aumenta pin del 10%); ai find della rigidezza si possono considerare regolari in

altezza strutture dotate di pareti o nuclei in c.a. o pareti e nuclet in nwratura di sezione costante

sull’altezza o di telal confroventati in acciaio, ai quali sia affidato almeno il 50% dell’azione
sismica alla base;

nelle strutture intelaiate progettate in CD “B” il rapporto tra resistenza effettiva’ e resistenza

richiesta dal calcolo non € significativamente diverso per orizzontamenti diversi (il rapporto fra

la resistenza effettiva e quella richiesta, calcolata ad un generico ornizzontamento, non deve
differire pin del 20% dall analogo rapporto determinato per un altro orizzontamento); pud fare
eccezione I'ultimo orizzontamento di strutture intelaiate di almeno tre ornzzontamenti;

h) eventuali restringimenti della sezione orizzontale della costruzione avvengono in modo graduale
da un orizzontamento al successivo, rispettando 1 seguenti limiti: ad ogni orizzontamento il
rientro non supera il 30% della dimensione corrispondente al primo orizzontamento, né il 20%
della dimensione corrispondente all” orizzontamento immediatamente sottostante. Fa eccezione
I'ultimo orizzontamento di costruzion di almeno quattro piani per il quale non sono previste
limitaziom di restringimento.

Per i ponti le condizioni di regolarita sono definite nel § 7.9.2.1.

[j=]
[ St

Come valutare la reqgolarita

strutturale!!l!

Regolarita

in piantalll!

Ly/Lx<4
Regolarita
in altezzallll
~30% L1

=20% Li
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Progetto struttura: regolarita

Es. Variazione della rigidezza degli elementi strutturali

) -
35
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%%

Per le masse si ragiona




Progetto struttura: regolarita

Regolarita strutturale

Sfavorevole

IJ':[

Favorevole

T

L 4

D—’l_——l

Rxgldezze
_A addizionali




Progetto struttura: regolarita elevazione

d ]AnaI|S| relgolarlta in elevazione indipendente F, =—>
ungo x e lungoy F,
[ Si assegna un profilo di carico che varia lungo F, =2 —
I'altezza dell’ edificio (prima lungo x e poi a — ——
A F,
parte lungo y, sono due analisi distinte!!!)

O Per strutture regolari & corretto usare
distribuzione in NTC2008, 7.3.6. NB per
strutture nn regolari occorrerebbe fare
considerazioni piu accurate!!! Per semplicita
adottiamo cmq questo profilo nei progetti del
corso!!!

[ Si valutano le variazioni di rigidezza tra un
piano e l'altro (prima lungo x e poi lungo y)



Progetto struttura: distribuzione forze tra i piani

O 7.3.3.2 Analisi lineare statica

L entita delle forze 51 othene dall’ordinata dello spettro di progetio comispondente al penedo T, e la
lore distribuzione sulla stuttura sezue la forma del modo di vibrare pnncipale nella direzione m
esame, valutatz in modo approssmmato.

La forza da applicare a clascuna massa della costuzione & data dalla formula seguente:

E=F z - W/ Eizj‘ii.-"j (7.3.6)
dove:
E=5,T)W-ig
F & la forza da applicare alla massa 1-es1ma;

W;e W; sono1pes, nspettrvamente, della massa 1 e della massaj;

zj € Zj sono le quote, nspette al prlane di fondazione (v. § 3.2.3.1), delle masse 18 j;

54T}  &l'ordinata dello spetivo di nsposta di progetto definito al § 3.2.3.5;

W & 1l peso complessive della costmzione;

A & un coefficiente pan a 0,85 se la costruzione ha almeno tre onzzontamenti e e T, < 2T,
pant a 1.0 o tuth gli altn casy;

E & 1'accelerazione di granata

Per gli edificy, se le nmdesze laterzhl & le masse sono distnbuite simmetncamente 1 pranta, gh

effetti forsiomali accidentalh di ewmn al & 7.2.6 possono essere consideratt amplificando le

sollecitazioni su ogm elemento resistente, caleolate con la distmbuzione formita dalla formula

(7.3 .6), attraverso 1l fattore (&) risultante dalla sezuente espressione:

6=1+ 0,6x/L, (7.3.7)
dove:
x & la distanza dell’slemento resistente verticale dal bancentro geomefmco di plano, misurata
parpendicolarmente alla direzione dell’azione sismica considerata;
L. &ladistanza tra1 due elementi resistentt pm lontam, misurata allo stesso modo.

o~



Progetto struttura: regolarita elevazione

Per valutare il valore delle rigidezze “traslazionale” del piano i-esimo:

F4 _>
V,mex=5.000kN -
3 é |
Fi=Vymex(z, W)/ Z(z; W) F, =2
F —
Dir X | Taglio di Piano [kN] | Spest. Interpiano[m] | K, [kN/m] | Scostamento 1
1° F,+F,+F;+F,=5.000kN | 0,0076 657.895
2° Fa+F3+F4=4.410kN 0,0100 441.000 -33%
3° Fy+F,=3.155kN 0,0097 325.250 -27%
47 F,=1.270kN 0,0043 295.350 -10%
Dir ¥ | Taglio di Piano [kN] | Spost. Interpiano[m] | K, [kN/m] | Scostamento
1® F,+F,+F;+F,=5.000kN | 0,011 454.550
2° Fo+F3+F4=4.410kN 0,016 275.625 -30%
3° F,+F,=3.155kN 0,016 197.185 -29%
4% F,=1.270kN 0,008 158.750 -20%

Kiat=taglio di piano / spostamento di interpiano

Come valutare la rigidezza traslazionale di piano e le
variazioni tra un piano e l'altro di tale rigidezza!!!

EW-N



Progetto struttura: tipologie strutturali

1 Dopo l'analisi di regolarita in pianta ed elevazione, occorre valutare la tipologia
strutturale

[ La norma definisce le tipologie strutturali in NTC2008 7.4.3.1

d Attenzione a valutare come prima cosa se la struttura & deformabile
torsionalmente

d Se la struttura risulta def. Torsionalmente cerchiamo di correggerne il
comportamento diminuendo opportunamente la eccentricita tra centro di massa
di piano (dove agiscono le forze sismiche) e centro di taglio di piano (dove agisce
la risultante delle reazioni di piano). Tale eccentricita induce le rotazioni del
piano!!!!

O Qualora nn fosse possibile intervenire per correggerne il comportamento
(inserendo dei setti, variandone le geometrie degli elementi,....) allora
assumiamo un g piu basso rispetto alle altre tipologie strutturali e quindi forze di
progetto piu alte!!!



Progetto struttura: tipologie strutturali

] Strutture deformabili (def.) torsionalmente

= Strutture che rispondono alla azione sismica con importanti rotazioni dei
piani orizzontali (xy) attorno all asse perpendicolare al piano (z)

= Ladissipazione della energia sismica per le strutture def. torsionalmente e
minore di quella di una struttura che risponde al sisma prevalentemente
traslando lungox ey

= (Queste incertezze di modello sono penalizzate assegnando alle strutture
dei fattori di struttura g bassi (forze di progetto piu grandi)

= NB la inerzia rotazionale va valutata in modo corretto in funzione della
reale forma dell impalcato e delle aperture in esso presenti. NN sempre
va bene la formula indicata in normativa per il raggio giratore!!!



743 TIPOLOGIE STRUTTURALIE FATTORIDI STRUTTIURA

7431 Tipologie soutturali

Le struffure sismo-resistenti in cemento armato previste dalle presenti norme possono essere
classificate nelle seguenti tipologie:

strunture a telgio, nelle quali 1a resistenza alle azioni sia verticali che orizzontali ¢ affidata
principalmente a telai spaziali. aventi resistenza a faglio alla base = 65% della resistenza a taglio
totale;

strunture a parefi, nelle quali la resistenza alle azioni sia verticali che onizzontali ¢ affidata
principalmente a pareti. singole o accoppiate, aventi resistenza a taglio alla base = 65% della
resistenza a taglio totale™;

strufture miste felnio-pareri, nelle quali la resistenza alle aziom verticali ¢ affidata
prevalentemente ai telai, 1a resistenza alle azioni orizzontali € affidata in parte ai telai ed in parte
alle pareti, singole o accoppiate; se pm del 50% dell azione orizzontale & assorbita dai telai s1
parla di strutture miste equivalenti a telai, altrimenti si parla di sfrutfure miste equivalenti a
parefi;

strutture deformabili torsionalmente, composte da telai e/o pareti, la cwi rigidezza torsionale non
soddisfa ad ogni piano la condizione /15 == 0,8, nella quale:

F]

Una parete & un elemento struttwrale di supporto per alin element: che ha una sezone trasversale carattenizzatza da un
rapporto fra dimensione massIma e MINima 10 planta superiore a 4. 51 definizce parete di forma composta 'insieme di
pareti semplici collegate in mode da formare semioni a L, T, U, I ecc. Una parete accoppiata consiste di due o pin
pareti singole collegate tra lovo da travt duthl “ravi di accopplaments’™) distnbmte in mode regolare lungo [altezza.
Al fim della determinazione del fattore di stuttura g una parete 51 defimsce accoppiata quando & venficata la
condizione ck

coppia prodot r' = rapporto tra rigidezza torsionale e flessionale di piano

12 =(L'+B)12  (LeB dimensioni in pianta del piano)

Tipologia strutturale!!l!

Dopo aver costruito il
modello 3D, lo analizziamo
e determiniamo la tipologia
strutturale!!l!l!

- struffure a pendolo inverso, nelle quali almeno i1 50% della massa & nel ferzo superiore
dell’altezza della costruzione o nelle quali la dissipazione d’energia avviene alla base di vn

singolo elemento strutturale”.

Le strutture delle costruziond in caleestmizzo possono essere classificate come appartenenti ad una
tipologia in una direzione orizzontale ed ad un’altra tipologia nella direzione orizzontale ortogonale
alla precedente.

Una struttura a parefi & da considerarsi come siruiitura a pareti estese debolmente armate se, nella
direzione orizzontale d'interesse, essa ha un periodo fondamentale, caleolato nell’ipotesi di assenza
di rotaziomi alla base, non superiore a To. e comprende almeno due pareti con una dimensione
orizzontale non inferiore al mindmo tra 4.0m ed 1 2/3 della loro altezza, che nella situazione sismica
portano insieme almeno i1 20% del carico gravitazionale.

Se una struttora non & classificata come struttura a pareti estese debolmente armate, tutte le sue
parefi devono essere progettate come duttili.



Progetto struttura: def. torsionalmente

O Si valutano le rigidezze traslazionali di piano F4 >
lungo x e lungo y (sono i risultati della analisi di ~ Fs —_—
regolarita in elevazione gia fatta!!!!

g 9 ) 2
—_—>

O Si valutano le rigidezze rotazionali di piano (una
per ogni piano)

O Si calcolano per ogni piano | rapporti tra
rigidezze traslazionali lungo x e rigidezze

rotazionali
M4 > |
O Si calcolano per ogni piano | rapporti tra —
- P2 e M3 &
rigidezze traslazionali lungo y e rigidezze
rotazionali e —
|
O Si stima il rapporto di normativa r/ls

O Si verifica che il rapporto di normativa r/ls sia nei
limiti definiti dalla norma per ogni piano!!!!



Progetto struttura: def. torsionalmente

Q Per valutare il valore delle rigidezze “traslazionale”
del piano i-esimo:

V,mex=5 000kN

Forza qualungque

da distribuire!!!

F2V,mox(z,W,)/E (2, W)

Kiat=taglio di piano / spostamento di interpiano

Dir X | Taglio di Piano [kN] | Spost. Interpiano[m] | K,;; [kN/m] | Scostamento
1° F,+F,+F,+F,=5.000kN | 0,0076 657.895

2° Fa+F3+F4,=4.410kN 0,0100 441.000 -33%

3® F,+F,=3.155kN 0,0097 325.250 -27%

4° F,=1.270kN 0,0043 295.350 -10%

Dir Y | Taglio di Piano [kKN] | Spost. Interpiano[m] | Ki; [kN/m] | Scostamento
1° F,+F,+F,+F,=5.000kN | 0,011 454.550

2° Fi+F3+F4=4.410kN 0,016 275.625 -30%

3° F,+F,=3.155kN 0,016 197.185 -29%

4 F,=1.270kN 0,008 158.750 -20%

F4 _>
B3 —y

I
F, =
I

Come valutare la
rigidezza
traslazionale di
piano e le variazioni
tra un piano e l'altro
di tale rigidezza!l!




Progetto struttura: def. torsionalmente

O Per valutare il valore delle rigidezze M4 D
“torsionali” del piano i-esimo:
|
M3 &
Kt=Mi/rotazione di interpiano
/ P M2 > —
Ml @ me———
momento qualungque
Mi=Mmx(z; Wi/ 2 (zy W) da distribuire!!! D
Taglio di Piano [kN] Rotazione K, [kN/m] Kot ¥ Kigr X r2 r
Interpiano [kN/m] | [kN/m]
1 M, +M,+M,+M,=5.000kNm | 0,00012 41.667.000 | 657.895 | 454.550 | 63,35 | 7,96
2° M, +M,+M, =4 375kNm 0,00013 33.654.000 | 441.000 | 275.625 | 76,30 | B, 73
3° M;+M,=3.120kNm 0,00013 24.000.000 | 325.250 ( 197.185 | 73,90 | 8,60
4= M,=1.270kNm 0,00004 31.750.000 | 295.350 | 158.750 | 107.5 | 10,3

v



Progetto struttura: def. torsionalmente

1 Si valuta lungo x e lungo y il rapporto r/Is per ogni piano

U Attenzione a Is in funzione della forma dell'impalcato (qui
approssimabile a un rettangolo)!!!

dSe un solo piano non rispetta i limiti di norma la struttura &
deformabile torsionalmente
(L2+B?)/12 . K, [kN/m] | K Y [kN/m] | n? . r/l,
1° (212+14,5%)/12=54,3 | 7,35 | 41.667.000 | 657.895 63,35 | 7,96 | 1,08
2° 54,3 7.35 | 33.654.000 | 441.000 76,30 | 8,73 [1,18 |t
3¢ 54,3 7.35 | 24.000.000 | 325.250 73,90 | 8,60 |1,17
4° 54,3 7.35 | 31.750.000 | 295.350 1075 (103 |14

- strutture deformabili torsionalmente, composte da telai e/o pareti, la cun rigidezza torsionale non
soddisfa ad ogni piano 1a condizione 1/l == 0.8, nella quale:

r’ = fapporto tra rigidezza torsionale e flessionale di piano

2 =(L'+B)12  (LeB dimensioni in pianta del piano)



Capacita Dissipativa o Classi di Duttilita (CD):
- Classe di duttilita alta (CD"A™);
- Classe di duttiliti bassa (CD"B™).

procedimenti tipici della gerarchia delle resistenze.

Nel caso la struttura abbia comportamento strutturale dissipativo, si distinguono due livelli d

La differenza tra le due classi risiede nella entita delle plasticizzaziom cwi ci si riconduce in fase d
progettazione; per ambedue le classi, onde assicurare alla struttura un comportamento dissipativo
duttile evitando rotture fragili e la formarione di meccanismy instabili imprevisti. si fa ricorso a

Classe di duttilita

secondo le NTC!!!!!

Valori del fattore di

struttura q0 secondo
NTC!!!

74.3.2 Fattori di stuttura

11 fattore di struttura da utilizzare per ciascuna direzione della azione sismica orizzontale & calcolato

come riportatonel § 7.3.1.

I massimi valori di qg relativi alle diverse tipologie ed alle due classi di duttilita considerate

(CD"A” e CDB™) sono contenuiti nella tabella seguente.

Tabella 7.4.I - Falori di qq

. . Ou
Tipologia CD"B” CD"A"
Strutture z telalo, a parett accoppiate, miste 300,y 4.5 ooy
Strutture a2 pareti non accoppiate 3.0 4.0 ooy
Strutture deformabali torsionalmente 2.0 3.0
Strutture 2 pendolo mverso 1.5 2.0
L& strutfure a parei esiese GeDoNNENie amIale OevVOono Essefe progefare il LD B . SITUiTIe avent

1 telai resistenti all’azione sismica composti, anche in una sola delle direzioni principali, con travi a
spessore devono essere progettate in CDB” a meno che fali travi non si possano considerare

elementi strutturali “secondan™.

Per strutture regolari in pianta, possono essere adottati 1 seguenti valori di og,/oy:

a) Strufture a telaio o miste equivalenti a telai

- strutture a telaio di un piano

- strutture a telaio con pin piani ed una sola campata
- strutture a telaio con pin piani e pit campate

b) Strutture a parefi o miste equivalenti a pareti

- strutture con solo due pareti non accoppiate per direzione orizzontale

- altre strutture a pareti non accoppiate
- strutture a pareti accoppiate o miste equivalenti a pareti

oo =11
oyfog =12
oo =13
ohylog =1.0
oo =1.1
oyfog =12

* Meon appartengono a questa categoria 1 telal ad un piano con 1 pilastn collegats in sommuta lungo entrambe le direziom
prncipali dell’edificio e per 1 quali la forza assizle non eccede 1l 30% della resistenza a compressione della sola

sezione di caleestruzzo.




Progetto struttura




Progetto struttura: modello

1 ESEMPI SAP2000

= CONSTRAIN DI PIANO (SIMULARE PIANO SOLAIO RIGIDO)
= SPECIAL JOINT (PER APPLICARE MASSE NEI BARICENTRI)

= SHELL (PIASTRE E SETTI)



%' SAP2000 Help

]

M= o

Mascondi Precedente  Awanti

=

Stampa

Contenuto | Indice | Cerca

EdIt = Linvide Frames

File = Mew Model = 2D Frames - Portal

@ Intreduction
(- Getting Started

@ Keyboard Commands and Special

=-{[J] Example Problems
----- 2] Introduction
----- 2] Problem A
----- 2] Problem B
----- 2] Problem C
----- 2] Problem D
----- 2] Problem E
----- 2] Problem F
----- 2] Problem G
----- 2] Problem H
----- 2] Problem |
----- 2] Problem J
----- 2] Problem K
----- 2] Problem L
----- 2] Problem M
----- 2] Problem N
----- 2] Problem O
----- 2] Problem P
----- 2] Problem G

4| 1n

»

m

B

Concrete Wall

Groups

Section Cuts

Load Combinations
Linear Replication

Assign = Assign to Groups

Assign > Joint Loads = Forces

Define = Section Properties > Area Sections
Define = Load Combinations

Define = Load Patterns

Define = Materials

Display = Show Tables

Edit = Replicate - Linear

File = Mew Model = Wall - Shear Wall

C

Truss Frame

Diaphragm
Constraint

Design Optimization
Automatic Area
Mesh

Mode Shapes

MNew Model (not from
template, started

Assign = Area = Automatic Area Mesh
Assign = Area Loads > Uniform (Shell)
Assign = Frame » Frame Sections
Assign = Joint = Constraints

Assign = Joint = Restraints

Define = Load Cases - Modal

Define = Section Properties = Area Sections
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Problem A

Concrete Wall and Steel Frame

Steel

Fy =36 ksi, E=29500 ksi, Poisson's Ratio =0.3

Caolumns: W10x43, typical - pinned base

Beams: As noted, pinned ends except continuous ov ertop of brace
Agsurne all W24x58 beams are braced at 1/3 points
Assurne WIBX36 bearns braced at center only

Beams at concrete wall are not embedded in wall

Braces: TSEXEX1/4, pinned ends
Design Code: AISC-ASDEY

Concrete
E = 4000 ksi, Poigsons Ratin=0.22

Self weight = 150 pcf

Beam Span Loading
Typical for all beamns; includes

50k self weight
_ WW2AXET WW2AXET 10KDL
Concrete wall BkLL 12iEDL
™ k
131 o B thick ¥ 08kIFLL
40k W2AKES W24KeE
» | Equal Equal
I T 1
13 ToDo
30k W2AKES W2ARES Dietarmine reactions for the load
T combination of DL +LL +EQ.
Determine steel stress ratios.
131
__20,k W24KEE W45 WV2AXEE YB36
13
10k
i iy WAAKES WWAAKES WEAKEE WW1EX 36
. &ﬂEarthquake
4 loads
AN AN FAY FAN
| e | o¢ 25 | | 14|
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Problem B

Concrete Wall
Concrete
E= 3600 ksi, Poissons Ratio =0.2

hodel wall using shell elements.
Determine shear axial force and
moment in Fier A, and determine
total shear, moment and axial force
at the sixth level for all piers
combined.

Earthguake
Loading

3 6 3

B' ] B |3)
I 1
imengions

[
Typical

POL =216k P(L)=72k
p
IPQEquaI |

P2
Equal |

Typical Bay Vertical | oading

Wall Thickness = 12 inches, typical

Lzlzpzz iz ez

| CSlSolution Demonstrates Use of These Features
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- Output
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Problem U
Barrel Vaulted Structure
Concrete

E =3600 ksi

Poissons Ratio =02

12" thick concrete walls
and slabs

To Do

Determine the maximum deflection
at the center of upper and lower
barrel vaults due to the self weight
of the structure. Also determine
the maximum deflection at center
of upper and lower barrel vaults
due to the self weight plus the
prescribed live load applied to the
top barrel vault.

Live Load =300 psf downward

I I

Barrel vault with
30 radius and 35°

T roll down angle
o

i

T Barrelvault with

- 20 radius and 35°
= rall down angle

CSI Solution Demonstrates Use of These Features

»  Add To Model From Template
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----- 2] Problem B i 4
_____ 2] Problem C roaf at one carner of the building. A 280 pound man sits on top of the flagpala.
----- 2] Problem D 5 p@e, 3w, 4y A,
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..... 7] Problem Q H-Dir (U1): 19594 UBC 52 - —
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----- 7] Problem T ' !
""" % PEHZE u Assumptions o Typical Floor and Roof Plan
_____ 2] Problem V = Diaphragms are rigid in plane,
_____ E Problem W = Columng are fixed base.
| E Probi \'( = Consider the mass of the A | —
a8 e E Pmblem . 260 pound man which is agpole 5
i @M'enu:’ =0 000085 kip-sec2in. &
| []"@ Qutput To Do =T
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Digitare |a parola chiave da cercare:

|sec1ion cut

advanced axes
plot function
section cut output convertions
Section Designer
rebar
Section headings
Section properties
assign area section
assign cable sections
assign frame sections
assign solid properties
assign tendon section
cable section data form
define area sections
define frequency dep. link props
frame section types
link: support property data form
select - area sections
select - cable properties
select -frame sections
select - link properties
select - solid properties
select -tendon properties
solid property data form
tendon section data form
Seismic loading
Select
3D box
all
area sections
cable properties
clear selection
coordinate axes or plane
deselect
frequency dependent link properties
get previous selection
aroups
intersecting pohy
invert selection
joint supports
labels
link properties
material properties
parallel to straight line

Visualizza |

IS |

=

| v

Draw Section Cuts
Form: Section Cut Stresses and Forces
Use the Draw menu > Draw Section Cuts command to display integrated forces along a specified section cut.

Note: Use this command after an analysis has been run (Analyze menu = Run Analysis) and with a deformed shape (with or without

results) displayed in the active window
(e.g., Display menu > Show Deformed Shape
Display menu > Forces/Stresses » Frames/Cable/Tendons

Display menu > Show Forces/Stresses » Shells
Display menu = Show Forces/Stresses = Asolids

Display menu > Show Forces/Stresses > Planes

Display menu > Show Forces/Stresses > Solids

Display menu > Show Forces/ Stresses = Links)

1. Use the Analyze menu > Run Analysis command to run an analysis.

2. SAP2000 will automatically display a deformed shape after the analysis has been run, which can be used in Step 3. Alternatively,
select an option from the Display menu to display results on the model. See the Display topics for more information about the
results that can be generated and the forms and options used in generating various result displays.

3. with the deformed shape displayed, click the Draw menu > Draw Section Cuts command.

4. Move the mouse pointer/cursor to the starting point of the section cut to be drawn on the deformed shape and click the left |-
mouse button. Drag the mouse to the ending point for the section cut. SAP2000 will display the Section Cut Stresses & Forces
form. The form has the following areas:

= Section Cutting Line Projected Coordinates, Start Point and End Point The X Y and Z values displayed in this area
of the form are the coordinates of the starting peint and ending point of the section cut. Type directly in these edit boxes
to adjust the location of the section, if necessary. Click the Refresh butten to complete relocation of the section cut and to
update the display of the integrated forces.

= Resultant Force Location and Angle The X ¥, Z values displayed in this area of the form are the coordinates of a peint
along the section cut. The initial values are the mid-point between the Start Point and End Point. Type revised values in the
edit box to display forces at another location along the section cut. The angle value is the angle measured
counterclockwise from the positive Global X axis to the positive X axis of the local coordinate system in which the
inteqrated forces are reported. The initial X direction is parallel to the section cut from the Start Point toward the End Point. =]
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Cortento e | Ger | Section Cuts ~

Digttare la parola chiave da cercare:

Form: Section Cuts, Section Cut Data

Isec{ion cut
= Use the Define menu > Section Cuts command to obtain resultant forces acting at sectien cuts through a model. Section cuts can be
advanced axes defined before or after an analysis has been run; however, it is safest to wait until after the analysis has been run. Typically do not define
plot function i : . i _— - i -
section cut output convertions section cuts, and more importantly, the groups used in the section cut definition, until all manual meshing of the model (if any) has been
Section Designer completed (see Frame - Automatic Frame Mesh, Area- Autematic Area Mesh or Solid - Automatic Solid Mesh for more infermation about
rebar ) . . . . .
Section headings meshing). If the groups are defined before manual meshing, some of the point cbjects that should be in the group may not yet be
Section properties created.

assign area section
assign cable sections Define section cuts as follows:

assign frame sections —
assign solid properties
assign tendon section 1
cable section data form :
define area sections

Define the group that is used to specify the extent of the section cut as follows.

define frequency dep. link props 1. Select the ohjects that are to be part of the section cut.
frame section types
link support property data form 2. Select the Assign menu > Assign to Group command to access the Assign/Define Group Names form.
select - area sections
select - cable properties 3. Click the Add New Group button to access the Group Definition form.
select -frame sections
:2:23 l;?lf dpr';"rgsgl'_ﬁ:s 4. Enter a name in the Group Name edit box. If it is not already checked, check the Section Cut Definition check box, and click
select -tendon properties the OK button.
solid property data form
S t?ndolr S?ion data form 5. Select the Add to Group option in the lower lefi-hand comer of the Assign/Define Group Names form and click the OK
EISMIC 103ain:
Select ? button.
3D box
all 2. Click the Define menu > Section Cuts command to access the Section Cuts form. Use the buttons on this form to add, modify,
area sections or delete section cuts,
cable properties
clear selection - ) . _ ;
coordinate axes or plane = Add Section Cut button. Click the Add Section Cut button to access the Section Cuts Data form, which has the
deselect ) ) following areas, optiens, and buttons:
frequency dependert link properties _|
gﬁlfpr:"'[’”s selection o Section Cut Name edit box. Use the default or type in a new name.
intersecting pol ) . . . . - . .
invert se|£1ﬁ,nh' o Coordinate System drop-down list. Choose the coordinate system in which the section cut will be defined.
joint supports
labels o Units drop-down list. Use the specified units or select new units from the drop-down list for the various values on
link properties the form.
matenal properties
parallel to straight line ;l

o Section Cut Defined By area. Choose an optien for defining the section cut.

Visuali - : - - : :
ﬂl * Group option. When this optien is selected, section cut results are reported for all elements included in the




E? SAP2000 Help

Hoe 2 &

=10l x|

Mascondi Precedente  Avarti Stampa
Contenuto  Indice | Canca =]
- _| ! Section Cut Plot Function
Digtare la parola chiave da cercare:
[section ot Use the Section Cut Plot Function form to specify the parameters for displaying section cut force functions.
- 1. Specify the section cut plot function to be displayed using the various options on the form:
advanced axes pecify P pay 1 P
plot function
S:;%ﬁ%g;fg‘;‘-ﬁ“f'—“ canventions = Section Cut drop-down list. Select the section cut, A function name will automatically appear in the Plot Function Name
rehar text box. This is the name of the plot function for display purposes.
Section headings
Section properties = Component area. Select the appropriate compenent (F1, F2, F3, M1, M2, M3).
assign area section
assign cable sections = Mode Number. Recover the time history for a particular mode as follows:
assign frame sections
i lid rti
::z:gﬂ f;’n'dfn“;‘;iﬂfﬁ 1. Select the indude One option.
cable section data form
define area sections . ] . :
define frequency dep. link props 2. Enter the mode number directly, or, use the spin button up and down arrows to select it frem the list.
frame section types
link: suppart property data form o . ’ . . . .
select - area sections Note: If the Indude All opticn is the only option available, the analysis case selected on the Plot Functions form is net a time
select - cable properties . .
select - frame sections history analysis.
select - link properties
select - solid properties . . . . i
select -tendon properties 2. Click the OK button to complete the definition of the section cut plot function and return to the Plot Function form.
solid property data form
t,anc:lon section data form 3. Define another function, or click the OK button to return to the Plot Function Trace Display Definition form. Refer to the Plot
gziz‘;‘c loading Functions topic for the additional steps required to display the section cut plot function.
3D box
all
area sections Access the Section Cut Plot Function form as follows:
cable properties
clear selection
sool‘?il‘lc?ie axes or plane 1. Definea Time History fundtion and a Time History load case: rurn an analysis.
esele
frequency dependert link properties . o . .
get previous selection i 2. Define a section cut if not already defined.
aroups
intersecting poly 3. dick the Display menu > Show Plot Functions command to display the Plot Function Trace Display Definition form.
invert selection
{Oitl;dlsuppoﬂs 4. dick the Define Plot Functions button to display the Plot Functions form.
abDels
!::té’;:f’sgsz o 5 Select the Add Section Cut Forces option from the Choose Function Type to Add drop-down list and dick the Add Plot Function
parallel to straight line | button, or highlight a previeusly defined section cut plot function definition and dick the Modify/Shew Plot button to display the —

Visualizza |

Section Cut Plot Function form.
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